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Motion Creator Pro 2 

前言 

版權所有 ©  2022 凌華科技 
 

本文檔包含受版權保護的專有信息。 保留所有權利。 未經製造商事先書面許可，不得以任何

機械、電子或其他方式以任何形式複製本手冊的任何部分。 

免責聲明 

本文檔中的信息如有更改，恕不另行通知，以提高可靠性、設計和功能，並不代表製造商的承

諾。 

在任何情況下，製造商均不對因使用或無法使用產品或文檔而引起的直接、間接、特殊、偶然

或後果性損害負責，即使已被告知此類損害的可能性。 

環境責任 

凌華科技致力於通過遵守歐盟的有害物質限制（RoHS）指令和廢棄電子

電氣設備（WEEE）指令來履行其對全球環境保護的社會責任。 環境保

護是凌華科技的首要任務。 我們已採取措施確保我們的產品、製造工

藝、組件和原材料對環境的影響盡可能小。 當產品達到使用壽命時，我

們鼓勵客戶根據其國家或公司規定的產品處置和/或回收計劃進行處置。 

商標 

此處提及的產品名稱僅用於識別目的，可能是其各自公司的商標和/或註冊商標。 

 

修訂記錄 

修訂 發佈日期 變更說明 

0.1 2022-12-30 Preliminary release 

0.2 2023-03-01 2nd edition for technical writer 
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1 概述 

ADLINK 為運動控制卡提供一個視覺化的使用者介面軟體 Motion Creator Pro 2，讓使用者可

快速、方便的操作 ADLINK 各類運動控制卡。Motion Creator Pro 2 簡稱 MCP2，所支援的運

動控制功能有單軸運動、軸參數設定、補間、監控、回 Home…等頁面，將依不同卡片所能支

援的功能呈現，本章節將主要以 PCIe-8338 所支援的功能做介紹。 

 
注意事項 

MCP2 軟體的執行路徑為：開始->程式集->ADLINK->ADLINK APS-SDK Utility-> Motion 

Creator Pro 2 ，點選即可開啟 MCP2。另外本軟體之畫面尺寸是以 1920X1080 設計，請盡量

使用大於此尺寸的解析度，以得到最佳的顯示效果。 



 

6 

Motion Creator Pro 2 

 

1.1 主畫面(Main Form) 

MCP2 軟體執行後會出現如下畫面，總共可分為 4 大區塊。 

 
A：功能表 (Menu) 

B：快速為多軸運動控制、取樣和設定參數等功能 (icon bar) 

C：裝置樹狀圖 (Device tree) 

D：功能頁面 (function pages) 

 

1.2 功能表((Menu) 

功能表內容包含下列五項:File (檔案)、View (檢視)、Initial_Options (初始化設定)、Function 

(功能)、About (關於)。 

注意：MCP2 開啟後，必須在裝置樹狀圖上點選 Card No 後 Function(功能)選項方能顯示。 

 
以下為功能表展開之所有功能 

1.2.1 File->Exit  

可關閉 MCP2 
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8 

Motion Creator Pro 2 

1.2.2 View->Project Tree  

用來打開/關閉 裝置樹狀圖 
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1.2.3 View ->Appearance 

用來改變 MCP2 外觀使用，此選單中的設定一旦更動，需重新開啟 MCP2 方能完成變更。 
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1.2.4 Initial Options->xxx Mode 

控制卡初始化選項，此選單中的設定一旦更動，需重新開啟 MCP2 方能完成變更。 

此處部分參數對應 APS_initial( I32 *BoardID_InBits， I32 Mode )，細節可參考 APS function 

library 手冊。 
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1.2.5 Initial Options->Appearance 

用來改變 MCP2 外觀使用，此選單中的設定一旦更動，需重新開啟 MCP2 方能完成變更。 

 

 
 

  

  

1.2.6 Initial Options->ProFiNetSpeed up Start 
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用來快速啟動 PCIe-8364RS 的 Slave 連線(用於初始連線後的啟動) 

 

1.2.7 About->Motion Creator Pro 2  

可打開版本資訊頁面，亦提供支援的硬體型號。 
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1.2.8 About->Error Code Data Query  

查詢 error code 的定義。 
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1.3 功能(Function) 

此功能選單會依據您在裝置樹狀圖中點選的是哪一種功能分類來做顯示，以下則列出相關功

能。下列三張圖分別說明在 Device tree 上點選 Card_No， Slave， 和 Axis 時，Function 

menu 所顯示可使用的功能選項。  

 
1. 點選 Card No ->Function 

2. 顯示選單如下圖，為各類與硬體或系統相關的功能。 
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1. 在樹狀圖的 Card No x的子項目，例如 Motion、EtherCAT AXIS、EtherCAT IO...等。 

2. 點選 Motion\EtherCAT Axis\EtherCAT IO\HSL BusNo X\MNET BusNo X->Function 

3. 顯示選單如下圖，為多軸運動控制、取樣和設定參數等功能。 
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1. 點選 Slave No ->Function  

2. 顯示選單如下圖，為單軸運動控制、點對點移動和回歸原點等功能。 

 

1.4 快速功能按鈕(Speed Button) 

快速功能按鈕區塊，經常使用的功能放入此區塊方便快速點選。如同 Function Menu 會依據使

用者在裝置樹狀圖選擇的是 Card No、Motion、Axis、Slave 來顯示不同的功能圖示。下面三

張圖示說明點選不同的項目所出現的圖示。 

 
如下裝置樹狀圖點選 Card No 0 出現 DIO，DSP Performance 等快速鈕。 
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2. 安裝指南 
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3. MCP2 Function list 

3.1  Parameter Manager 

本控制卡上所有的軸參數和系統參數設定可統一由此頁面所管理。這些參數包括運行模

式、加速速率、減速速率，加加速度，運動 I/O 邏輯等。有關定義和詳細描述，請參見APS 

Function Library參數表。 

打開參數設定頁面如下圖 Step1 和 Step2 所示: 

Step1.先在裝置樹狀圖中點選的 Card or Slave or Axis 

Step2.在快速功能按鈕上再點 Board/Axis Para 功能按鈕即可。 
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3.1.1 參數配置(Parameter Configuration) 

Board Configuration 內容請參閱 APS Function Library手冊 Table definition-> Board 

Parameter table 
如下圖為例 PCIe-8338 的板卡 

 
Board Configuration 頁面可參考內容 

38. Table definition->A. Board Parameter table->PCIe-833x board parameter table 
如下圖 

 
 
Axis Configuration 內容請參閱 APS Function Library手冊 Table definition-> Axis Parameter 

table 
如下圖為例 PCIe-8338 的板卡 
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Axis Configuration 頁面可參考內容 

38. Table definition->A. Board Parameter table->PCIe-833x Axis parameter table 
如下圖 

 



 

22 

Motion Creator Pro 2 

 

3.1.2 儲存卡和軸參數(Save Board and Axis Parameter) 

在頁面的下方有數個參數操作的按鈕，依照系統設定將參數設定完畢後可選擇下列幾種儲存/

載入方式： 

 
Set To Card：將參數設定值直接寫入至控制卡中使用。 

Load From Card：從控制卡中讀取參數至頁面顯示。 

Save To Flash：將參數寫入至控制卡中的非揮發性記憶體。 

Load From Flash：從控制卡中非揮發性記憶體讀取參數至頁面顯示。 

Save To File：將參數寫入至指定的檔案中(*xml)。 

Load From File：從指定檔案讀取參數至頁面顯示(*xml)。 

Load Default：載入出廠預設值至頁面顯示。 

3.1.3 統一設定軸參數(Apply All) 

    在一運動控制系統中，可能有多軸的參數是類似或完全相同的情況，MCP2 提供一個複製

參數設定值到多軸的功能，不需再每軸一一做參數設定。使用方法為在設定軸參數設定頁面上

按滑鼠右鍵，即可跳出欲設定的選項。 

Apply all(Single Parameter)：只複製該欄的設定值至其它軸。 

Apply all(All Parameter)：複製該軸的所有參數值至其它軸。
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3.2 Homing 

該Homing頁面用於軸的原點(ORG)位置模式及參數設定。透過軸參數設置程序，選擇幾

種模式，用戶無需編寫歸零序列即可完成返回原點的運動。設置完成後，將根據原點的物理位

置來更新軸的位置。此功能為“發後即忘”的方式。這就意味著在軸運動期間不會掛起用戶的

程序或過程。用戶必須使用運動狀態檢查功能或中斷事件等待功能來等待它完成。 

打開回歸原點頁面步驟如下圖(1)~(2)所示，首先在裝置樹列上點選”Axis X”，再至快速功能按

鈕點選 Home Move 功能按鈕。 
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回歸原點頁面可分為四大區塊： 

 
(1) 回原點各類參數設定。 

(2) 開始/停止鈕和設定/載入參數。 

(3) 狀態顯示區。 

 Motion Status 其對應內容請參閱 APS Function Library手冊 Table definition-> Motion 

status definition tables 
例如上圖為 PCIe-8338 Motion Status 參考內容路徑為 

38. Table definition-> F. Motion status definition table -> PCIe-833x Motion status 
definition table 

如下圖 
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 Motion IO Status 其對應內容請參閱 APS Function Library手冊 Table definition->Motion 

IO status and motion status definitions 
例如上圖為 PCIe-8338 Motion IO Status 參考內容路徑為 

38. Table definition-> E. Motion IO status and motion status definitions -> PCIe-
833x motion IO status table 

如下圖 

 
(4) 圖示目前回原點的方式。 
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3.3 Single Move  

單軸操作功能可控制某單一軸做絕對運動、相對運動、速度運動和吋動等功能，並可即時

監控命令、位移、速度和各類運動狀態資訊。 

打開單軸操作頁面步驟如下圖(1)~(2)所示:首先在裝置樹列上點選”Axis X”，再至快速功能按鈕

點選 Single Move 功能按鈕。 
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3.3.1 位移/命令狀態(Position/Command Status) 

此區塊顯示的各類資訊如下： 

Command：目前的命令位置 

Position：目前的回授位置 

Cmd Vel：目前的命令速度 

FBK Vel：目前的回授速度 

Err Pos：位移誤差值 

TargetPos：目標位置 

Set Pos：同時設定目命令位置和回授位置 

MaxVel：設定點對點運動時的最大速度 

 
 



 

28 

Motion Creator Pro 2 

 

3.3.2 運動操作(Move Operation) 

運動操作可分四種操作模式，輸入的位移量皆是以 Pulse 為單位。 

 
(1) ABS MOVE：絕對位置移動，可輸入絕對位置 

(2) REL MOVE：相對位置移動，可輸入相對位置 

(3) VEL MOVE：速度移動，可輸入速度 

(4) JOG MOVE：吋動，點選 Free 或 Step mode. (Step mode 須設定位移量) 

 

※加減速率可在 3.1 參數管理中設定。 

如需執行兩個位移間的往複來回運動時，可勾選 Repeat Move 和設定間隔時間 Delay Time

後，再執行運動操作。 
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3.3.3 狀態顯示區(Status View) 

狀態顯示區即時回饋控制器上的資訊，包含Motion Status、Motion IO Status、Interrupt、

Error Interrupt四區塊。 

 
 Motion Status 

 
對應內容請參閱 APS Function Library 手冊 Table definition-> Motion status definition tables 

例如上圖為 PCIe-8338 Motion Status 參考內容路徑為 

38. Table definition-> F. Motion status definition table -> PCIe-833x Motion status 
definition table 

如下圖 

 
如有伺服異常停止的情況，Soft motion 系列軸卡可點選”ASTP”查得停止的原因。 
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 Motion IO Status 

 
對應內容請參閱 APS Function Library 手冊 Table definition->Motion IO status and motion 

status definitions 
例如上圖為 PCIe-8338 Motion IO Status 參考內容路徑為 

38. Table definition-> E. Motion IO status and motion status definitions -> PCIe-833x 
motion IO status table 

如下圖 
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 Interrupt 

 
對應內容請參閱 APS Function Library 手冊 Table definition-> Interrupt factor table 

例如上圖為 PCIe-8338 Interrupt 參考內容路徑為 

38. Table definition-> G. Interrupt factor table -> PCIe-833x Interrupt Item Definition 
Table 
如下圖 
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 Error Interrupt(僅 Pulse type 軸卡) 

 
對應內容請參閱 APS Function Library 手冊 Table definition-> Interrupt factor table-> Interrupt 

Item Definition Table-> Axes error interrupt definition of Items 

例如上圖為 PCIe-8158 Error Interrupt 參考內容路徑為 

38. Table definition-> G. Interrupt factor table -> PCI(e)-8154/8158， PCI-8102 Axes 

error interrupt definition of Items 
如下圖 
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3.4 Interpolation 

補間功能適合使用於一軸以上對於位移量有交互關係的運動控制系統中，其型式有2軸線

性、2軸圓弧、3軸線性…等而補間功能分為Pulse type 軸卡與Soft motion 軸卡兩種頁面設

定，其相對應的設定參數亦略有不同。 

打開補間頁面的方式如下圖(1)~(2)步驟，依照不同軸卡點選裝置樹列中的”Slave”或

者”Motion”，再點選快速功能按鈕上的”Interpolation 鈕”。 

 
 
 Pulse type 軸卡頁面 
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設定功能分為 2 頁面 

Linear 頁面 

 
(1) 選擇欲做補間運動的軸號及位移量。 

(2) Abs Mode/Rel Mode：設定絕對或相對運動以及位移量。 

Start/Stop：啟動命令及停止命令 

(3) 監測各軸命令及回授 
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2D Arc 頁面 

 
(1) 選擇欲做 2D Arc 運動的軸號及旋轉量、中心點、速度、轉向。 

(2) Abs /Rel：設定絕對或相對運動。 

Start/Stop：啟動命令及停止命令 

(3) 監測各軸命令及回授 
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 Soft motion 軸卡頁面 

 
設定 Soft motion 軸卡補間功能大致上可分為 8 區塊 

 
(1) Interpolation Type：在 11 種補間型式中選擇運動類型對應 API 如下。 

Interpolation Type  

2DLinear APS_line_all 

3DLinear APS_line_all 

4DLinear APS_line_all 

5DLinear APS_line_all 

6DLinear APS_line_all 

2DARC_A APS_arc2_ca_all 

2DARC_E APS_arc2_ce_all 

3DARC_A APS_arc3_ca_all 
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3DARC_E APS_arc3_ce_all 

3DSPH_A APS_spiral_ca_all 

3DSPH_E APS_spiral_ce_all 

(2) Choose Axis：選擇欲做補間運動的軸號。 

(3) Absolute/Relative：設定絕對或相對運動以及位移量。 

(4) Parameter Source：選擇速度參數的來源。 

Parameter Source Description 

User input 使用區塊(3)中的速度參數 

Axis parameter 使用目前軸參數的設定(軸參數頁面請

參考 3.1 及 APS 手冊設定) 

Only Vmax 使用區塊(3)中的速度參數，但最大速

使用參考 3.1 及 APS 手冊設定 

(5) 如需執行兩個位移間的往複來回運動時，可勾選 Repeat Move 和設定間隔時間 Delay 

Time 後，再執行運動操作。 

(6) Speed Parameter：輸入各個速度設定值，若在區塊(1)中選擇的參數來源為 user input

時，區塊(4)的操作將可使用此處的設定。 

(7) 開始與停止運動操作控制。 

(8) 選擇的模式示意。 
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3.5 Sampling 

取樣頁面功能可在運動控制過程中，將各種命令、位置、速度等資料做採集再一併顯示在

圖表上顯示，以利調機或做後續分析工作。 

打開取樣頁面步驟如下圖(1)~(2)所示:首先在裝置樹列上點選”Slave”或”Motion”，再至快速功

能按鈕點選 Sampling 功能按鈕。 
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3.5.1 繪圖區(Drawing Area) 

    取樣功能一次可同時採集四種不同的資料，而不同的資料型別其單位和數值刻度可能不盡

相同，因此繪圖區中左半邊的 Y 座標軸 channel1~channel4 為各 channel 獨立的刻度如下圖

(1)，而橫向 X 座標軸則固定為時間軸其最小單位為 millisecond。 

 
在下圖(2)區塊，可對資料顯示方式做設定，其功能如下: 

1. 選擇該 channel 是否顯示 

2. 自動調整資料至填滿繪圖區 

3. 將各通道的資料 Y 座標軸對齊於某一指定通道顯示。 

 

3.5.2 取樣設定(Sampling Setting) 

取樣設定主要可分為三個步驟，分別為： 

(1) 決定對哪一運動軸做取樣，和其取樣的資料型別，如位置、速度等。 

(2) 設定取樣速度、點數和決定觸發取樣通道等。 

(3) 設定完後可顯則單次(Single)或連續(Repeat)觸發模式。 

Start Sampling：開始做取樣 

Stop Sampling：按鈕可停止動作 

Sampling Clear：可清除繪圖區資料 

Data Export：將取樣資料輸出至檔案(*.csv 格式) 

Data Import：將取樣資料檔案輸入(*.csv格式) 
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3.5.3 16CH Sampling 

  16CH 取樣功能一次可同時採集 4、8、16 種不同的資料的選擇如下圖，而不同的資料型別其

單位和數值刻度可能不盡相同。目前僅支援 EtherCAT 系列。 

 
因此繪圖區中左半邊的 Y 座標軸 channel1~channel16 為各 channel 獨立的刻度如下圖(1)，而

橫向 X 座標軸則固定為時間軸其最小單位為 millisecond。 
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取樣設定主要可分為三個步驟，分別為： 

(1) 決定對哪一運動軸做取樣，和其取樣的資料型別，如位置、速度等。 

(2) 設定取樣速度、點數和決定觸發取樣通道等。 

(3) 設定完後可顯則單次(Single)或連續(Repeat)觸發模式。 

Start Sampling：開始做取樣 

Stop Sampling：按鈕可停止動作 

Sampling Clear：可清除繪圖區資料 

Data Export：將取樣資料輸出至檔案(*.csv 格式) 

Data Import：將取樣資料檔案輸入(*.csv格式) 

Image Export：擷取圖片 
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3.6 Setup Wizard 

Setup Wizard為一個讓您快速設定個軸的參數配置的工具，藉由著一步一步地引導頁

面，協助您方便、有效地將系統設置完成。我們建議在進行任何運動控制操作前(剛開始使用

本控制卡時)，第一個步驟可以先執行此功能。Setup Wizard可達成下列幾項目的： 

1. 控制卡基本參數設定: 包括控制模式，伺服週期，安全設定等 

2. 配線檢查: I/O, Encoder 等 

3. 伺服調機 (類比，閉迴路控制模式) : 提供Auto tuning功能，協助使用者找出一組穩定

且具有一定性能的伺服參數。 

打開 Setup Wizard 頁面步驟如下圖(1)~(2)所示:首先在裝置樹列上點選”Axis X”，再至快速功

能按鈕點選 Setup Wizard 功能按鈕。 

3.6.1 控制模式(Control Mode) 

設定各軸控制模式為 Analog Type 或 Pulse Type，點選 Change 按鈕後會出現一個新頁面供

您設定各軸的輸出訊號型式。設定完畢後請按 Save/Reboot 按鈕，此時需等待一段存檔和控

制卡的重置的時間，最後再離開(Exit)。 

 
如下圖所示打開伺服控制率更新速度設定畫面，填入適當的 Servo Loop Update Rate 後按

Save/Reboot 按鈕等待控制卡重置(Reset)。 
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3.6.2 安全保護(Safety Protection) 

此步驟包含 Error-Check-Level 和 soft-limit 的保護設定，請設定是否啟動功能和條件參數。一

旦有變更設定 Set 按鈕將會加註*號以提醒您需點選 Set 按鈕以便將參數寫入硬體。 
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3.6.3 確認控制邏輯(Motion IO Check) 

設定 Motion IO 的正反向訊號，各 IO 即時狀況如 LED 燈號所顯示，並分別由下圖箭頭中指向

的區域設定邏輯。 

 
設定相關邏輯訊號，直到所有 IO LED 燈號熄滅為止，如下圖。 
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3.6.4 確認編碼器(Encoder Check) 

設定 Encoder Mode 和 Encoder Direction 後按 Set 寫入設定值。 
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3.6.5 輸出測試(Output Test) 

(1) 切換到輸出測試頁面時，將自動詢問您是否要將 PID 和 Filter 等參數皆清除，請點選

“Yes“選項清除所有設定，該軸 PID 參數設定為 0 (Disable)，Filter 參數設定為無作用

(bypass)。若選擇 No 則不做任何設定。 

 
(2) 將馬達 Servo On 後，下圖中由紅色虛線框選的部份用來設定 V-Offset 值，一開始請先從

Scale 選擇單次移動刻度的大小為 1V、0.1V 或 0.003V，再使用滑鼠滾輪或鍵盤的左右鍵

來調整 V-Offset 至適當值後可進行下一步驟。
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3.6.6 自動調適(Auto Tuning) 

2.1~2.5 節的設定皆完成後，將進入到此節的自動調適功能，這會依照您的運動控制系統自動

計算出一組適當的 PID 值。 

 
(1) 確認軸號是否正確， 

(2) 點選 Start Tuning 按鈕開始進行調適動作(可能需等待一段時間)。 

(3) 視該軸震動狀況調整 Amplitude (震動震幅)。若震幅太小 Auto-tuning 程序無法計算出 PID

值。 

(4) 反覆(2) ~ (3)找到一組 PID 值。顯示在右方 Result 中。Fluctuation 表示計算收斂的狀況，

該值越小越好。 

(5) 當程序完成後需點 Set Final 按鈕將 PID 值寫入到控制卡中，此時已完 auto-tuning 程序。 
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執行完 Wizard 後，代表該軸相關的基本參數已經設置完畢，可以進行單軸運動的操作或是定

位運動操作(homing)。另外，可至軸參數設置頁面 3.1.1 檢視該軸參數的設置或進行儲存參數

的動作。 
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3.7 E-GEAR 

電子齒輪功能分為Standard和Gantry兩種模式，Standard模式在主/從動軸可設定齒輪

比，控制器將依據您所設定的齒輪比在主/從動軸輸出不同的位移量。而Gantry模式主/從動軸

的齒輪比為固定的1:1，適用於主/從動軸需同動且位移量相同的情況，通常應用於龍門控制系

統。 

打開電子齒輪頁面的方式如下圖(1)~(3)步驟，依照不同軸卡點選裝置樹列中的”Slave”或

者”Motion”，再點選快速功能按鈕上的”Egear 鈕”，此時會跳出一警告訊息，提醒您使用電子

齒輪前應該注意的事項。 

 

 
 
 
設定電子齒輪 
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(1) 設定該軸為 Standard 或 Gantry 模式 

(2) 選擇主軸編號和訊號來源 

(3) 設定齒輪比參數 

Standard 模式時設定 Ratio 和 Engage Rate 

 
Gantry模式時設定 Deviation 的保護量 

Level1:Stop Move 
Level2:Servo Off 

 
(4) 將參數值寫入控制器，並設定是否啟動 
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(5) 設定主軸最大速度及位置 

(6) 如需執行兩個位移間的往複來回運動時，可勾選 Repeat Move 和設定間隔時間 Delay 

Time 後，再執行運動操作 

(7) ABS MOVE：絕對位置移動，可輸入絕對位置 

REL MOVE：相對位置移動，可輸入相對位置 
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3.8 DIO 

不同軸卡所支援的DIO組數不同。 

打開 DIO 頁面的方式如下圖(1)~(2)步驟，依照不同軸卡點選裝置樹列中的”Card No X”，再點

選快速功能按鈕上的”DIO Control 鈕”。 

 
如欲設定數位輸出值可在該組開關上點選即可 
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3.9 AIO 

不同軸卡所支援的AIO組數不同，設定類比輸出時可使用捲軸拉動或是直接輸入電壓值。 

打開 AIO 頁面的方式如下圖(1)~(2)步驟，依照不同軸卡點選裝置樹列中的”Card No X”，再點

選快速功能按鈕上的”AIO Control 鈕”。 

 

設定類比輸出時可使用捲軸拉動或是直接輸入電壓值，最後再按 Set 鈕。 
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3.10 PDO 

PDO (Process Data)頁面可實現PDO (Process Data Object)週期性資料的讀寫交換。 

打開 PDO 頁面的方式如下圖(1)~(2)步驟，點選裝置樹列中的點選裝置樹列中” EtherCAT Axis”

或者” EtherCAT Axis IO”，再點選快速功能按鈕上的”PDO 鈕”。 
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使用者可以針對 PDO 所需要的內容輸入需求 

(1) TxPDO : Salve 從站送出的一個程序資料物件(PDO)，使用者可將從站想傳入的 offset，

Value (Size 為 Value 的位元組大小，當填入 offset 後系統會自動帶入) 填入編輯欄位內後按下

Write 按鈕進行寫入，也可以針對想知道的 Value 輸入對應的 offset 值後按下 Read 按鈕來讀

取。 

(2)RxPDO: Slave 從站收到的一個程序資料物件(PDO)，同樣針對想知道的 Value 輸入對應的

offset 值按下 Read 按鈕來讀取，就可以得到 value 以及相對應的 Size 大小。 
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3.11 SDO 

SO (Slave Operation)頁面可以透過SDO的通信OD(Object Dictionary)數據讀寫，獲取

Slave的特定數據。進一步達到參數配置和狀態監視。 

打開 SDO 頁面的方式如下圖(1)~(2)步驟，依照不同”Slave”點選裝置樹列中的(Slave X)xxxxx 

xxxx”，再點選快速功能按鈕上的”SO 鈕”。 
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SO 控制按鈕則會出現下列頁面，此時使用者可以看到四個子頁面 

1. General 

 
(1) 針對 EtherCAT Slave 狀態設定。 

(2) Remote Update：更新 File over EtherCAT 功能，詳情請洽 ADLINK 服務窗口。 

2. Slave PDO 會列出此從站可透過 PDO 操作的 object dictionary，透過 Read/Write 按鈕來

操作 

 
(1) Write:輸入在 TxPDO 表內欲操作名稱 OD 的 SubModule, Index，並參考 Data Type 

Name 以及 Bit Length 輸入對應的 Value 按下 Write 按鈕。 

(2) Read:輸入在 RxPDO 表內欲操作名稱 OD 的 SubModule, Index 按下 Read 按鈕可得

其值。 
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3. ESC Register Operation 

 
(1) 針對 EtherCAT Slave Controller 讀取資訊以及寫入資訊頁面 

4. SDO Dictionary的頁面會列出所有的服務資料物件，使用者可以透過畫面中的 Read 

/Write 按鈕來進行操作 

 
 

(1) Read：輸入 Index、SubIndex、Bit Length、Data Type 後，按下 Read 後隨即在

Value 欄位內顯示所需的值。 

(2) Write：輸入 Index、SubIndex、Bit Length、Data Type 按下 Write 按鈕即可設定所

需的值。 
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3.12 Field module 

ADLINK slave專有的頁面，依照Slave Axis 或Slave IO，有不同呈現功能。 

3.12.1 ADLINK Slave Axis 

打開 Field module 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Slave X ”，

再至快速功能按鈕點選 Field module 功能按鈕。 
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以 ECAT-4XMO 為例，分為兩個區塊 

 
(1) 每一個軸的狀態顯示。 

(2) 針對 ADLINK slave 常用的 SDO 組態支援設定。 
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3.12.2 ADLINK Slave IO 

打開 Field module 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選 DIO 或 

AIO，再至快速功能按鈕點選 Field module 功能按鈕。 

 
以 EU-6000 等相關商品為例，分為四種不同的 DIO 及 AIO 設定 
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3.13 Axis info 

Axis info頁面可監控新增或移除自訂義多軸的運動狀態、命令、回授、速度、加速度..等

數據監測。 

打開多軸資訊頁面步驟如下圖方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Slave X”

或”Motion”， 再至快速功能按鈕點選 Axes Info 功能按鈕。 

 
頁面內容如下 

 
Add Row : 增加多個監控來源的列，可透過下拉式選單選擇如 Cmd_Pos、Cmd_Vel、

Fbk_Pos、Fbk_Vel .. 等監控來源。 

Del Row : 刪除勾選的監控來源列。 

Clear All : 刪除所有監控來源列。 
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Add Column : 增加多個監控軸的行，可透過下拉式選單選擇欲監控的軸號。 

Del Column: 刪除勾選的監控軸。 

Clear All : 刪除所有監控軸。 
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3.14 Advanced Point Table 

進階點表提供了使用者自行規劃出的二維多點執行連續運動的功能並將運動軌跡顯示在圖

表上，其運動內容包含絕對直線運動、圓弧運動或相對直線、圓弧運動..等，使用者可自行設

定每個點運動的基本參數並儲存成檔案供後續使用。 

打開 APT 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Slave X ”，再至快速

功能按鈕點選 APT 功能按鈕。 
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3.14.1 繪圖區(Drawing Area) 

 
可將使用者所設定好的 2 維點運動軌跡顯示在此區(1)，綠色線(Path Planning)為控制命令的

軌跡，而粉紅色線(Tracer Path)為實際運動的軌跡，繪圖功能(2)設定如下: 

Path Source : 可選擇是實際運動位置或命令位置 

Axis X,Y : 選擇 2 維運動的軸 ID 

Tracer Path Clear : 將實際運動軌跡從繪圖區清除 

Path Redraw :重新繪製控制命令軌跡 
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3.14.2 命令配置區(Configuration Area) 

(1) 在此 Point Table List 按右鍵後可新增或刪除點運動 

 
(2) 在格子內滑鼠左鍵點兩下即可編輯此運動命令的資訊，如 Point 0, Axis X 的位置為

100000，其他資訊以此類推 

 
(3) 在 Option 格子內按右鍵可勾選此運動的進階配置，例如 Abs(絕對運動)、Rel(相對運

動)、Linear(線性)、Arc(圓弧)….等 
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3.14.3 操作區(Operation Area) 

點選 Operation Tab 後可看到如下三個區塊: 

(1) 監控兩軸的命令以及回授位置。 

(2) 監控目前命令點位已經執行到第幾點，點表的 Buffer 狀態以及選擇哪個 Point Table。 

(3) 監控填點器執行時間、狀態以及 Buffer 狀態。 

(4) Star : 開始點表運動。 

Stop: 停止點表運動。 

Pause: 暫停表運動。 

Rollback : 在 Pause 狀態使用 VRback 設定的速度回到上一點的運動位置。 

Resume : 在 Pause 情況下繼續點運動。 
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3.15 手動設置 Slave ID (Manual ID) 

手動ID提供了使用者自行設定每個Slave ID號，詳細的手動ID流程會在後續說明。 

打開手動 ID 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Slave X ”，再至快

速功能按鈕點選 Manual ID 功能按鈕。 

 

Manual ID 資訊內容如下 
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Auto Slave ID : 表內列出系統自動排列從 0 到 65535 的 Slave ID 號。 

Manual Slave ID Source：  

目前 PCIe-833x都是讀取方式則是讀取 ESC 上的 Configured Station Alias Register 的資料而

來定義為 SII，另一種模式透過讀取 AL Status Code 來得到 ID-Selector 的資訊定義為 AL 

Control 
該資訊需搭配 board parameter 選擇不同的讀取方式來進行讀取 ID 資訊，設定請參閱 APS 

Function Library 手冊 

 
 
Manual Slave ID : 左鍵點兩下後可自行編輯欲設定的 Slave ID。 

Save to Slave : 將設定好的 Slave ID 寫入 Slave 的 EEPROM。 

Save to File : 將此配置存成一個 xml 檔案。 

Load From File : 載入一個 xml 檔案並顯示在表內。 
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3.16 (DSP/Kernel Performance 

核心效能提供使用者目前EtherCAT cycle time 和 Motion cycle time、消耗時間、以及

負載情況，此外也提供了使用者更改目前cycle time的設定。 

打開核心效能頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選” Card No X ”，再

至快速功能按鈕點選核心效能功能按鈕。 
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3.16.1 DSP Performance 

 
 Spend time: 目前運算所每周期所耗費時間 (單位 Nano-second) 

 Max spend time: 到目前為止所耗費的最大時間 (單位 Nano-second) 

 Loading: 目前週期中所佔的比例(工作比重) (100%) 

 Max loading: 記錄到最大的 DSP 工作比重(100%) 

 Overload Cnt:過附載累計次數 

3.16.2 Kernel Performance 

 
 Spend Time : 實際系統消耗時間，單位為 Micro-second。 

 Cycle Time : 實際系統的 cycle time，單位為 Micro-second。 

 Max Spend Time : MCP2 估算的系統最大消耗時間，單位為 Micro-second。 

 Loading : MCP2 估算系統目前運算負載百分比(%)。 

 Max Loading : MCP2 估算系統目前最大負載百分比(%) 

 Overload Cnt:過附載累計次數 
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3.16.3 如何設定 EtherCAT Cycle time 

1. 在下拉式選單選擇要設定的 cycle time 

 
2. 點選 Save To Flash 按鈕。 

3. 點選 Reboot 按鈕後會跳出提示視窗(請先確認 Field Bus 已斷線後再執行) 

 
4. 等待的時候會出現功能按鈕會反白直到系統重置後會恢復正常。 

 
5. 點選 Card No X，點選 Axis/Board Para 快速功能按鈕開啟頁面，點選 Save to Flash

鈕。 
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3.17 Compare Trigger 

比較觸發功能分為線性比較法(Linear Compare)和表格比較法(Table Compare)，當比較

到使用者設定的條件時再相對應的動作。 

打開觸發功能頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹依據不同的軸卡列上點

選”Slave X ”或”Motion”，再至快速功能按鈕點選觸發功能功能按鈕。 
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比較觸發功能設定介紹如下 

 
(1) Select trigger source：選擇各通道的觸發來源訊號 

(2) Trigger Count：顯示各通道已觸發的數量 

(3) Reset：清除已觸發的數量 Manual：手動給予觸發訊號 

(4) Trigger Parameter：比較觸發的參數設定，不同軸卡有不同的設定，參數請內容請參閱

APS Function Library 手冊 Table definition-> Trigger parameter table 

上圖為 ADLINK 的 AMP-304C 產品，因此對應手冊內容如下圖 
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(5) Linear Comparator Setting：線性比較器設定 
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(6) Table Comparator Setting：表格比較器設定 

 
(7) Timer Setting：計時器設定  
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3.18 Latch 

位置閂鎖功能讓使用者閂鎖瞬間位置，再針對位置做相對應的訊號輸出或運動反應。 

以下圖示顯示了”Latch”操作方式 

打開 Latch 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Axis X ”，再至快速

功能按鈕點選 Latch 功能按鈕。 
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打開 Latch 頁面操作區(Operation Area)三個區塊 

 
(1) Latch FIFO 狀態，定期的更新使用者所選擇的通道 FIFO 狀態，以及重置與使用狀態。 

(2) 取得使用者選取的通道 FIFO點資訊，包含閂鎖位置及來源，並且列印到表單上供使用者

參考，當不用的時候可按右鍵點選單一點資訊或全部移除。 

(3) Latch 的相關參數設定，如 latch 通道號、來源、閂鎖的編碼器號以及閂鎖的邏輯條件

等，當這些配置好之後再 enable。設定參數請內容請參閱 APS Function Library 手冊

Table definition-> Latch parameter table 
上圖為 ADLINK 的 ECAT-4XMO 產品，因此對應手冊內容如下圖 
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3.19 OPT Device OD 

OPT Device OD頁面是SDO頁面的延伸，使用者可以選擇想要的SDO的通信OD(Object 

Dictionary)數據讀寫，獲取Slave的特定數據及監視。 

打開 OPT Device OD 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Slave 

X ”，再至快速功能按鈕點選 OPT Device OD 功能按鈕。 

 
OPT Device OD 功能設定介紹如下 

(1) +/- OD 為產生選擇的 SLAVE SDO 
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(2) 產生後的 OD Data 會顯示在 Available，在項目上連續點擊滑鼠兩下或者使用中間的向右

按鈕(如下圖)，即選擇想要的 OD Data 

 
(3) 選擇後結果如下，並切換 User Defined OD 分頁 
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(4) 分頁會呈現必要的 OD 資訊，如項目最右側無反白 Write 為可寫入的 OD Data 

 
(5) 分頁右下角分別為 

 WriteALL：一次寫入 OD Data 

 Save to file：儲存使用者自定義的 OD Data(*.csv 格式) 

 Load from file：匯入使用者自定義的 OD Data(*.csv格式) 
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3.20 IO 映射(IO Mapping) 

3.20.1 EtherCAT 

IO 映射不建議手動修改配置文件的內容。請使用 MCP2 IO 映射頁面進行映射和檢查。 

對於每種類型的 IO，軟體端口最大支援數量為”32”。 

• IO 映射配置文件可以通過 MCP2 IO 映射形式保存到”CSV”文件。 

• IO 映射配置文件設置只能透過 MCP2 設定。用戶要寫入配置文件，請是用 APS 的 API

將配置結果寫入。 

• 無需重新映射 ADLINK 已整合過的模組。 

以下是使用 MCP2 設置 IO 映射配置的操作步驟說明 

步驟 1： 

更新 kernel 版本：C:\Program Files (x86)\ADLINK\PCIe-833x\Kernel Update 

功能版本需求要 2022050503_833x_kernel 以上版本 

 
步驟 2： 

打開 IO 映射頁面步驟方式如下圖(1)~(2)步驟所示，EtherCAT 連線後，首先在裝置樹列上點

選”EtherCAT IO”，再至快速功能按鈕點選 IO 映射功能按鈕。 
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步驟 2-1 ( 選擇 DIO 映射 )： 

選擇需要 Slave IO 來映射。參考可配置 PDO 視窗進行對應的設定。

 

○1  選擇需要 Slave IO 映射，參考可配置 PDO 視窗。 

○2  勾選需要設置的 IO 類型。 

○3  SlaveID 填寫需要映射 Slave ID。 

SubMod No. 填寫對應的 SubMod No，請參考可配置 PDO 視窗中的 SubMod No。

Index 填寫起始 Index。 請參考可配置 PDO 視圖內容中的 Index 訪問起始位置。 

○4   Access Length 填寫定義端口需要的 IO Bit. 

DIO 映射參數： 

- SlaveID：需要映射 Slave ID。 

- SubMod No.：可配置的 PDO 視圖 

- Index：根據可配置的 PDO 視圖內容中的 Index 訪問起始位置。 

- Access Length：根據可配置 PDO 視圖內容中的 Bit Length 訪問端口長度。 

最大值：32 位 

最小值：1 位 

- Port_No：自動生成。 
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步驟 2-2 ( 選擇 AIO 映射 )： 

選擇需要 Slave IO 來映射。參考可配置的 PDO 參數進行對應的設定。

 

○1  選擇需要 Slave IO 映射，參考可配置 PDO 視窗。 

○2  勾選需要設置的 IO 類型。 

○3  SlaveID 填寫需要映射 Slave ID。 

  SubMod No. 填寫對應的 SubMod No，請參考可配置 PDO 視窗中的 SubMod No。 

  Index 填寫起始 Index。 請參考可配置 PDO 視圖內容中的 Index 訪問起始位置。 

○4   Access Length 填寫定義端口需要的 IO Bit。 

○5  LowerBound 填寫物理量下限。 

      UpperBound 填寫物理量上限。 

  Data type 填寫物理量類型 

(0：無符號整數、1：有符號整數、2：以 MSB 為符號的絕對值 、3：原始數據) 

AIO 映射參數： 

- SlaveID：需要映射 Slave ID。 

- SubMod No.：可配置的 PDO 視圖 

- Index：根據可配置的 PDO 視圖內容中的 Index 訪問起始位置。 

- Access Length：根據可配置 PDO 視圖內容中的 Bit Length 訪問端口長度。(注

意：長度必需正確) 

- LowerBound：物理量下限。 

- UpperBound：物理量上限。 

- Data type：物理量類型。 

- 類型 0(無符號整數) 
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- 例如 16 bits = 0 to +65535 

- 類型 1(有符號整數) 

- 例如 for 16 bits = -32768 to +32767 

- 類型 2(以 MSB 為符號的絕對值) 

- 例如 for 16 bits = -32767 to +32767 

- 類型 3(原始數據) 

- Ch_No：自動生成。 

 

步驟 2-3 ：(用戶定義 PDO 映射) 

添加和刪除行有兩種方法： 

- 右鍵單擊表格 

 
- 使用鍵盤添加(Ctrl+enter)、 刪除(Ctrl+delete) 

 
提示： 

- 將鼠標移到表格上會出現提示。 

  
用戶定義的 DIO 映射提示 
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用戶定義的 AIO 映射提示 
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步驟 3：  

單擊 Apply Mapping 按鈕。 可配置的 PDO 視圖將映射結果顯示。樹狀圖也會顯示軟體定義的

Port No 或 Channel No。 

 
DIO mapping 顯示軟體定義的 Port No 

 
AIO mapping 顯示軟體定義的 Channel No 
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步驟 4： 

如果選擇樹狀圖定義 Port No 會顯示連線模組按鈕功能。開啟後即可開始控制 DO\DI(視窗預

設為 32 組 DO 或 DI Port)。該 DO\DI 控制位是來自於用戶設置的長度。如果控制超出用戶設

置的 DIO 長度，將返回錯誤代碼。

 
如果選擇樹狀圖定義 Channel No 會顯示連線模組按鈕功能。開啟後即可開始控制 AO/AI (視

窗預設為 1 組 channel)。 
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以下是使用 MCP2 保存/加載文件並應用映射指令操作步驟說明 

步驟 1： 

單擊“保存到文件”按鈕將 IO 映射設定數據導出到文件。

 
步驟 2： 

單擊從”文件加載”按鈕，會導入 IO 映射設定數據並檢查文件內容。
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3.20.2 ProFiNet 

ProFiNet 的 Slave Device 上的 Motion IO 需使用 Slave IO 做為映射使用，因此需要 IO 

Mapping，對應其 Motion IO。 

打開 IO Mapping 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Card No 

X ”，再至快速功能按鈕點選 IO Mapping 功能按鈕。 

 
ProFiNet IO Mapping分為兩頁面 Mapping 

 Device Mapping 是將需要的 Axis Motion IO 映射到 Device DI，並設定到 ProFiNet 卡。 

 
(1) 設定 Device DI 映射至 Axis Motion IO 表。 

(2) 三個按鈕分為 

Set to Card：設定到 ProFiNet 卡。 
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Save To File：將參數寫入至指定的檔案中(*csv)。 

Load From File：從指定檔案讀取參數至頁面顯示(*csv)。 

 Trigger Mapping 是將需要 Trigger Output 映射到 Device DO，並設定到 ProFiNet 卡。 

 
(1) 設定 Device DO 映射至 Trigger Output 表。 

(2) 三個按鈕分為 

Set to Card：設定到 ProFiNet 卡。 

Save To File：將參數寫入至指定的檔案中(*csv)。 

Load From File：從指定檔案讀取參數至頁面顯示(*csv)。 
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3.21 CST Mode 

CST(Cyclic Synchronous Torque)模式下，軌跡發生器位於控制裝置中，而不是伺服驅

動器中。它以循環同步的方式向驅動裝置提供目標扭矩，驅動裝置執行扭矩控制。 

打開 CST Mode 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Axis X”，再至

快速功能按鈕點選 CST Mode 功能按鈕。 
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3.21.1 CST Mode 頁面兩大區塊 

 
(1) CST Mode 參數設定及控制 

 
1. 切換 CSP/CST 模式。 

2. 設定轉矩停止(Stop)時間值以及選擇 Slop or reach Time 及目標轉矩方式。 

3. 設定 Torque cmd(%) 及 Torque stop。 
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(2)  狀態顯示及初始設定 

 
1. 狀態顯示區：顯示目標扭矩值、實際扭矩值及回授位置。 

2. 命令模式切換到 CST mode 時的初始扭矩值，可為自定義轉矩設定或當下實際轉

矩值。 

3.21.2 CST Mode 操作步驟 

(1) 將要操作的軸 servo on，如果未 servo on 無法操作 CST mode 
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(2) 切換為 CST mode，並設定轉矩停止(Stop)時間值及選擇 Slop or reach Time 及目標轉矩

方式。 

 
(3) 如要命令模式切換到 CST mode 時的初始扭矩，請先在以下位置設定好，否則預設為 0 
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(4) 設定要達到的轉矩值並按下 Set Cmd(0.1%)後開始動作。 

 
 



 

99 

Motion Creator Pro 2 

 

3.22 Compensation 

Compensation提供1D及2D運動的補償表設定及可匯出檔案。 

打開 Compensation 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點選”Slave 

X ”，再至快速功能按鈕點選 Compensation 功能按鈕。 
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3.22.1 1D Compensation 

 
(1) 設定參數 

 Compensation Axis：設定補償的軸 

 Compensation Type：補償型態(Linear 或 Constant) 

 Total Points：補償多少點 

 Start Position：補償起點 

 Interval：補償點間距 

(2) 輸入補償量 

(3) 其他功能 

 Set Table：設定補償量參數後，將參數寫入 

 Disable/Enable：開啟補償 

 Data Export：儲存補償數據(*csv) 

 Data Import：補償數據匯入(*csv) 
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3.22.2 2D Compensation 

 
(1) 設定參數 

 Compensation Axis：設定 2 維補償的軸 

 Total Points：2 維補償多少點 

 Start Position：2 維補償起點 

 Interval：補償點間距 

(2) 輸入 2 維補償量 

(3) 其他功能 

 Set Table：設定 2 維補償量參數後，將參數寫入 

 Disable/Enable：開啟補償 

 Data Export：儲存 2 維補償數據(*csv) 

 Data Import：2 維補償數據匯入(*csv) 
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3.23 Connect Quality 

Connect Quality頁面為監測連線品質使用，可確認Slave連線品質。 

打開 Connect Quality 頁面步驟方式如下圖(1)~(2)步驟所示，首先在裝置樹列上點

選”EtherCAT Axis”或”EtherCAT IO”，再至快速功能按鈕點選 Connect Quality 功能按鈕。 

 



 

103 

Motion Creator Pro 2 

Connect Quality 有兩分頁 

3.23.1 Connect Quality 

 
(1) 品質監測參數勾選以及更新速率。 

品質監測主要目的：當硬體信號到達相鄰的 Slave 時，接收到的信號卻與最初發送的不一

致檢測。當發生這類情況，最有可能的原因是：1. 如果該錯誤計數零星增加，極可能是

外部 EMC 干擾。2.如果該錯誤計數快速且穩步增加，極可能是設備損壞。 

品質監測參數 

 Invalid Frame Counter (port 0) 
檢測到無效的 frame(包括 RX 錯誤) 

 RX Error Counter (port 0) 
檢測到物理層 RX 錯誤 

 Forward Error Counter (port 0) 
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檢測到先前 ESC(EtherCAT Slave Controller) 無效的 frame。 

 Invalid Frame Counter (port 1) 
檢測到無效的 frame(包括 RX 錯誤) 

 RX Error Counter (port 1) 
檢測到物理層 RX 錯誤 

 Forward Error Counter (port 1) 
檢測到先前 ESC(EtherCAT Slave Controller) 無效的 frame。 

 ECAT Process Unit Error Counter 
檢測到 EtherCAT 流程的有無效的 frame。 

(2) 連線品質等級分類 

根據使用者選擇勾選的計數值，取最大計數值當成影響最深的因子進而使用相對應的燈

號。 

(3) 品質狀態監控。 

 



 

105 

Motion Creator Pro 2 

 

3.23.2 State Control 

 
(1) EtherCAT Master 目前狀態。 

(2) 多組針對 EtherCAT Slave 目前狀態及切換設定選項 
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4. Application 

4.1  


